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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, without the prior written permission of Seiko Epson Corporation. The information 
contained herein is designed only for use with this Epson product. Epson is not responsible for any 
use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or 
third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result 
of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to 
this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s 
operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original Epson Products or 
Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials
Digital cameras, scanners, and ink jet printers, like conventional photocopiers and cameras, can be 
misused by improper copying or printing of copyrighted material. While some countries’ laws 
permit limited copying of copyrighted material in certain circumstances, those circumstances may 
not be as broad as some people assume. Epson encourages each user to be responsible and respectful 
of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks
Epson and Epson Stylus are registered trademarks and Exceed Your Vision is a trademark of Seiko 
Epson Corporation. 

DURABrite and RPM are registered trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be 
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

© 2005 Epson America, Inc. 5/05 
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Introduction

The Epson Stylus® C87 printer is the ideal desktop printer for business and home 
use. With its exceptional speed and print resolutions, it is practical for everyday 
tasks, yet capable of delivering superior photo printing. 

The Stylus C87 features Epson’s exclusive DURABrite® Ultra pigment inks. These 
quick-drying inks are resistant to water, fading, and smudging on plain and photo 
paper—so your prints stand the test of time. Because the ink particles remain near 
the surface and don’t bleed through, they’re ideal for double-sided prints.

Note: The light resistance of prints is rated up to 100 years on specialty papers, and 70 
years on plain paper. The light resistance rating is based on accelerated testing of prints 
on Epson® special media, displayed indoors, under glass. Actual print stability will vary 
according to media, printed image, display conditions, light intensity, humidity, and 
other atmospheric conditions. Epson does not guarantee the longevity of prints. For 
maximum print life, display all prints under glass or lamination or properly store them.

After you have set up your Epson Stylus C87 as described on the Start Here sheet, 
use these instructions to:

■ Load paper

■ Print from Windows® or on a Macintosh®

■ Replace ink cartridges

■ Solve simple problems

For more information about your printer, see the on-screen User’s Guide. An icon 
for the manual was automatically placed on your desktop when you installed the 
software.

Please follow these guidelines as you read the instructions:

Warning: Warnings must be followed carefully to avoid bodily injury.

Caution: Cautions must be observed to avoid damage to your equipment.

Note: Notes contain important information about your printer.

Tip: Tips contain hints for better printing.
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Loading Paper

The type of paper you choose affects the way your printout looks, so be sure to 
select the correct paper for your job. If you are just printing a rough draft, plain 
paper is fine. For best results, however, you’ll want to use one of Epson’s special ink 
jet papers designed for your printer. For example, your photos will look great 
printed on Epson Premium Glossy Photo Paper. See page 15 for more 
information.

Follow these steps to load paper in your printer:

1. Open the output tray and pull out its extension.

2. Squeeze the left edge guide and slide it to the left.



Loading Paper 7

3. Insert the paper, printable side up, against the right edge guide. Then slide the 
left edge guide against the paper (but not too tightly).

Note: You can load up to 100 sheets of plain paper and up to 20 sheets of most 
types of photo paper. (See the on-screen User’s Guide for specific paper capacity 
guidelines.)

Follow these guidelines when loading paper:

■ Don’t load paper above the arrow on the left edge guide.

■ Load the printable side face-up. It’s often brighter or whiter than the 
other side.

■ Always load the short edge first, even when printing in landscape mode.

■ Load letterhead or preprinted paper into the printer top edge first.

■ If you experience paper feeding problems, try loading fewer sheets.

■ If you’re using special paper, check the package for special loading 
instructions.

Letter or 
8 × 10-inch paper

4 x 6-inch or 
5 x 7-inch paper
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Basic Printing

Follow the instructions in this section for basic printing of your documents. For 
Windows, see below. For Macintosh OS X, see page 11. 

If you are printing photographs, also see page 17 for more information about 
printing photos.

Printing in Windows

1. Open the File menu and select Print. You see a Print window like this one:

2. Make sure EPSON Stylus C87 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the 
next screen.)

Click here to 
open your printer 
software

Select EPSON Stylus C87 Series
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You see the basic print settings window:

4. Select from these Quality Option settings:

■ Draft: For rough drafts with reduced print quality

■ Text: For text-only documents with higher text quality

■ Text & Image: For documents with text and images with higher quality

■ Photo: For photos and graphics with good quality and speed

■ Best Photo: For photos or graphics with high print quality

5. Select the correct paper Type and Size settings for the paper you loaded in 
the printer. See “Selecting the Correct Paper Type” on page 16.

6. Select Portrait or Landscape for the Orientation setting.

Select the type 
of document 
you’re printing

Select your 
paper Type

Select your 
paper Size

Select your 
document or 
image orientation

Click here for 
more options
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7. For more printing options, click the Advanced button. Then select the 
following settings as necessary.

Note: For more information about advanced settings, or instructions on saving 
them as a group so you can reuse them later, click ? or Help. 

8. If you want to change the layout settings, click the Page Layout tab and 
select settings as necessary.

9. Click OK to save your settings, then click OK or Print to start printing.

Select a color management method 
(To choose No Color Adjustment, 
click ICM first)

Click here to select 
Photo RPM® for the 
best print quality on 
certain paper types

Select Print Options 
as necessary

Select Paper & Quality 
Options as necessary

Click here if you want to see this Advanced 
screen each time you access your print settings
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During printing, this window appears to show the progress of your print job. You 
can use the buttons to cancel, pause, or resume printing. You can also see how 
much ink you have left.

Tip: You can also cancel printing by pressing the paper button on your printer.

Printing with Macintosh OS X

Follow the steps below for basic printing of your Macintosh OS X documents. 
Before you begin, make sure you added your printer to the Print Center as 
described on the Start Here sheet.

1. Open the File menu and select Page Setup. You see the Page Setup window:

Cancel printing

Pause or resume 
printing

Check remaining 
ink levels

Select Stylus C87

Select your Paper Size

Select your document 
or image orientation
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2. Select Stylus C87 in the Format for pop-up menu.

3. Select your Paper Size. For borderless printing, choose a paper size with the 
Sheet Feeder-Borderless option.

4. Select  portrait or  landscape for the orientation.

5. Click OK.

6. Open the File menu and select Print. You see a window like this one:

7. Select Stylus C87 in the Printer pop-up menu.

8. Select Print Settings from the pop-up menu.

9. Select the following Print Settings as necessary:

Select Print Settings

Select Stylus C87

Select your Media 
Type (see page 16)

Select Color or 
Black ink

Select higher 
quality or faster 
printing (if available)

Select 
Automatic mode
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Depending on your settings, you can choose these other options from the 
pop-up menu:

■ Copies & Pages: Select the number of copies you want, or a page range.

■ Layout: Select page layout options.

■ Output Options: Save your print job as a PDF file.

■ Scheduler: Schedule your print job to print at a later time.

■ Paper Handling: Select page printing options, such as Reverse print 
order.

■ ColorSync or Color Management: Select ColorSync® or adjust the 
color controls, change the gamma setting, or turn off color adjustments in 
the printer software.

■ Expansion: Reduce or enlarge the image size for borderless printing.

■ Summary: View a list of all your selections.

10. Click the Advanced button to change these settings:

Note: For more information on advanced settings, or instructions on saving them 
as a group so you can reuse them later, click ?.

11. Click Print.

Select Photo RPM 
for the best print 
quality on certain 
paper types
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12. To monitor the progress of your print job, click the  printer icon when it 
appears in the dock on the bottom of your desktop. 

If you’re using OS X 10.2.x, click the  Print Center icon instead, then 
double-click Stylus C87 in the Printer List window. 

You see a screen like this:

Tip: You can also cancel printing by pressing the ) paper button on your printer.

13. When you’re finished, close the printer window or Print Center.

Cancel printing

Resume printingPause printing

Select the 
print job
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Using Special Papers

You can use the following special Epson papers in your Stylus C87.

* The availability of paper types and sizes varies by location.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. 
To find the nearest reseller, please call your nearest Epson sales office as described 
in “Where To Get Help” on page 34.

Paper name* Size Part number

Epson Ultra Premium 
Glossy Photo Paper

Borderless 4 × 6 in. (102 × 152 mm) S041934

Letter (8.5 × 11 in. [216 × 279 mm]) S041935

Epson Premium Bright 
White Paper

Letter (8.5 × 11 in. [216 × 279 mm]) S041586

Epson Premium Glossy 
Photo Paper

Borderless 4 × 6 in. (102 × 152 mm) S041808 
S041727

Borderless 8 × 10 in. (203 × 254 mm) S041465

Letter (8.5 × 11 in. [216 × 279 mm]) S041286

Epson Premium 
Semigloss Photo Paper

Letter (8.5 × 11 in. [216 × 279 mm]) S041331

Epson Glossy Photo Paper  4 × 6 in. (102 × 152 mm) S041809

Letter (8.5 × 11 in. [216 × 279 mm]) S041141

Epson Matte Paper 
Heavyweight

Letter (8.5 × 11 in. [216 × 279 mm]) S041257

Epson Semigloss 
Scrapbook Photo Paper

Letter (8.5 × 11 in. [216 × 279 mm]) SCR1001

PremierArt™ Matte 
Scrapbook Photo Paper for 
Epson

Letter (8.5 × 11 in. [216 × 279 mm]) SCR1002

Epson Double-Sided 
Matte Paper

Letter (8.5 × 11 in. [216 × 279 mm]) S041568
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Selecting the Correct Paper Type

Be sure to select the correct Type or Media Type setting in your printer software:  

For this paper Select this setting

Plain paper

Epson Premium Bright White Paper

Plain Paper/Bright White Paper

Epson Ultra Premium Glossy Photo Paper Ultra Premium Glossy Photo Paper

Epson Premium Glossy Photo Paper Premium Glossy Photo Paper

Epson Premium Semigloss Photo Paper Premium Semigloss Photo Paper

Epson Glossy Photo Paper Glossy Photo Paper

Epson Matte Paper Heavyweight

Epson Double-Sided Matte Paper

Epson Photo Quality Ink Jet Paper

Matte Paper - Heavyweight

Envelopes Envelope
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Printing Photos 

You can print beautiful snapshots and enlargements with or without white 
borders. With proper care, photographs from your Epson Stylus C87 will last for 
many years. For best results, always use Epson papers. (See “Using Special Papers” 
on page 15 for more information.)

As with traditional photos, Epson recommends proper care that will minimize 
color changes and lengthen display life: 

■ Frame prints under glass or in a protective plastic sleeve to protect them from 
atmospheric contaminants like humidity, smoke, and high levels of ozone.

■ As with all photographs, keep your prints away from direct sunlight.

■ For proper storage, keep your prints in a photo album or plastic photo storage 
box in acid-free, archival sleeves commonly available from most camera stores.

■ Always keep unused paper in the original package. 

For instructions on loading photo paper, see page 6. Then see below for printing 
in Windows, or page 21 for printing in Mac OS® X.

Printing Photos in Windows

1. Open the File menu and click Print. 

2. Make sure your printer is selected, then click Properties or Preferences. (If 
you see a Setup, Printer, or Options button, click it. Then click Properties 
or Preferences on the next screen.)
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You see a window like this one:

3. Select Photo or Best Photo as the Quality Option setting.

4. Select the paper Type for the paper you’re using. (See page 16.)

5. For pictures without white borders, click the Borderless checkbox. Read the 
message and click OK. 

6. Select your paper Size setting. 

7. Select Portrait or Landscape as the orientation setting.

8. Do one of the following:

■ Click OK, then click OK or Print. 

■ If you want to print at the highest resolution possible, or use special 
settings, continue with the steps in the next section.

Select Photo or 
Best Photo

Click here 
for photos 
without 
white 
borders

Click here for 
more settings; 
then see page 19
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Customizing Your Photo Settings

1. On the Main tab, click the Advanced button in the bottom right corner of 
the window. If you see a warning note, click Continue.

2. Select the following advanced settings as necessary:

Note: For the highest print quality, select Photo RPM. Please note that printing will 
take longer in this mode and it is not available if you choose the Borderless 
checkbox.

For more information about the print settings, click ? or Help.

3. Once you’ve finished selecting advanced settings, you can:

■ Click OK to save your settings, return to the Print window, and print.

■ Click the Basic button to return to the basic settings.

■ Click the Page Layout tab and continue with step 4 to select layout 
options.

Select a color management method 
(To choose No Color Adjustment, 
click ICM first)

Click here to select 
Photo RPM (5760 × 1440) 
for the best print quality 
on certain paper types

Adjust 
colors here
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4. Select the following page layout settings as necessary:

Note: Some layout settings may not be available, depending on other settings you 
chose.

5. Select image position or resizing options as necessary. These affect only your 
printed image, and are not available for borderless printing.

6. If you’re printing borderless photos, you can 
adjust the Expansion slider to choose Min, 
Max, or the in-between setting.

Min is the least amount of image expansion; 
there may be a small white edge on the borders 
of the print. Max expands the image to ensure 
that there are no unprinted edges, but the edges 
of the image may not appear in the print. 

7. Click OK to save your settings, then click OK or Print.

Select image 
resizing 
options here

Select image 
position 
options here

Adjust 
borderless 
setting here (see 
step 6, below)



Printing Photos with Macintosh OS X 21

Printing Photos with Macintosh OS X

1. Start your photo program and open your photo file.

2. Open the File menu and select Page Setup. You see a window like this one:

3. Select Stylus C87 in the Format for pop-up menu.

4. Select your Paper Size. For borderless photos, choose one of the following:

■ 4 × 6 (Sheet Feeder-Borderless)

■ 5 × 7 (Sheet Feeder-Borderless)

■ 8 × 10 (Sheet Feeder-Borderless)

■ Letter (Sheet Feeder-Borderless)

5. Select  portrait or  landscape as the orientation setting.

6. Click OK.

7. Open the File menu and click Print. 

Select Stylus C87

Select your Paper Size
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8. Select Stylus C87 in the Printer menu and select Print Settings from the 
pop-up menu. You see a window like this one:

9. Select the correct Media Type option to match the paper you’re using. 
(See “Selecting the Correct Paper Type” on page 16 for more information.)

10. Select Quality (for higher quality) or Speed (for faster printing) using the 
slider.

11. Do one of the following:

■ Click Print.

■ If you want to print at a higher resolution or use special settings, continue 
with the steps in the next section.

Select Print Settings 
from the list

Select Stylus C87

Click Advanced 
for more options
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Customizing Your Photo Settings

1. Click the Advanced button.

2. Select these advanced settings as necessary:

Note: For the highest print quality, select Photo RPM. Note that printing will take 
longer in this mode.

For more information on advanced settings, or instructions on saving them as a 
group so you can reuse them later, click the ? button.

3. If you’re printing photos without white borders, select Expansion from the 
pop-up menu. You see a window like this one:

For color 
management 
settings, select 
Color Management 
from the list

Click here to select 
Photo RPM (5760 × 
1440) for the best 
print quality on 
certain paper types
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4. Adjust the Expansion slider to choose Min, Max, or the in-between setting.

Min is the least amount of image expansion; there may be a small white edge 
on the borders of the print. Max expands the image to ensure that there are 
no unprinted edges, but the edges of the image may not appear in the print. 

5. Click Print.
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Replacing Ink Cartridges

When the red H ink light flashes, one or more ink cartridges are low on ink.

When the red H ink light stays on, you need to replace the cartridge(s).

When you print, you’ll also see a message on your screen telling you which 
cartridge is low or empty.

When a cartridge is more than six months old, you may need to replace it if 
printouts don’t look their best. If the quality doesn’t improve after cleaning and 
aligning the print head, you can replace the cartridge even if the red H ink light 
is off.

Note: You cannot continue printing with one ink cartridge empty, even if the other 
cartridges still contain ink. Before printing, replace the empty cartridge.

Purchasing Ink Cartridges

Use these Epson ink cartridges within six months of installing them and before the 
expiration date on the package.

To ensure good results, use genuine Epson ink cartridges and do not refill them. 
Other products may cause damage to your printer not covered by Epson’s 
warranty.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. 
To find the nearest reseller, please call your nearest Epson sales office as described 
in “Where To Get Help” on page 34.

Ink cartridge Part number 

Black T063120

Cyan T063220

Magenta T063320

Yellow T063420
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Ink Cartridge Precautions
Warning: Keep ink cartridges out of the reach of children and don’t drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your 
eyes, flush them immediately with water.

Caution: Don’t remove the cartridge label, or ink will leak. 

Don’t remove the green IC chip from the cartridge. Installing a cartridge without an IC 
chip can damage the printer. Avoid touching the green IC chip, as this can damage the 
ink cartridge.

If you remove an ink cartridge temporarily, protect the ink supply port on the bottom of 
the cartridge from dirt and dust. Place it in the original packaging, if you still have it, or in 
a small box.

Store ink cartridges in the same environment as the printer. Stand the cartridges 
upright (the label identifying the color should be on top).

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session.

Caution: Leave the empty/low cartridge installed until you have obtained a 
replacement, or the ink remaining in the print head nozzles may dry out. 

1. Make sure the printer is turned on (the green P power light should be on, 
but not flashing). 

2. Open the printer cover.
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3. Press and release the H ink button. 

The ink cartridge holder moves to the left, and the cartridge that needs to be 
replaced stops under the _ ink out mark. The P power light flashes. 

Caution: To avoid damaging the printer, never move the print head by hand.

Note: Don’t hold down the H ink button for more than 3 seconds, or the printer will 
start to clean the print head.

If no cartridge needs to be replaced, the holder moves to the ink cartridge 
replacement position, shown on the next page. Go to step 5.

4. Press the H ink button again.

■ If more than one cartridge is empty, the next cartridge moves under the 
_ ink out mark.
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■ If all the empty cartridges have been identified, the print head moves right 
to the ink cartridge replacement position, shown below.

5. Open the cartridge cover.
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6. Squeeze the back tab of the empty/low cartridge and lift it out of the printer. 
Don’t take the used cartridge apart or try to refill it.

Warning: If ink gets on your hands, wash them thoroughly with soap and water. If 
ink gets into your eyes, flush them immediately with water.

7. Before you remove the new cartridge from its package, shake it four or five 
times. Then remove it from the package.

Caution: Do not remove or tear the 
label on the cartridge; otherwise ink will 
leak. 

Don’t touch the green chip on the front 
of the cartridge; you may inhibit normal 
operation and printing.

Don’t touch 
the green part
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8. Lower the cartridge into the holder and push it down until it clicks into place

9. If you need to replace other ink cartridges, repeat steps 6 through 8 before 
continuing with step 9.

10. Close the ink cartridge cover and make sure you hear it click into place.

11. Close the printer cover.

12. Press the H ink button. The printer begins charging the ink delivery system.

The green P power light flashes and the printer makes noise. Charging takes 
about half a minute. When it’s finished, the green P power light stops 
flashing and stays on, and the red H light goes out.

Caution: Never turn off the printer while the green P power light is flashing, or 
you’ll waste ink.

Note: If the red H light stays on (not flashing), the ink cartridge may not be installed 
correctly. Press the H ink button again and reinstall the ink cartridge until it clicks 
into place.
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Solving Problems

If you have a problem with your Epson Stylus C87, check the printer’s lights (as 
described below) to diagnose what may be causing it. 

You can also see “Problems and Solutions” on page 32 for basic troubleshooting 
suggestions, or read your on-screen User’s Guide for more detailed help.

If you cannot solve the problem, see “Where To Get Help” on page 34.

Checking the Printer’s Lights

Lights Explanation

Green P power 
light flashes

The printer is receiving a print job, replacing an ink cartridge, 
charging ink, or cleaning the print head.

Red ) paper light 
is on

Your paper ran out. Load more paper, then press the ) paper 
button to resume printing. 

Red ) paper light 
flashes

Paper is jammed in the printer. Press the ) paper button to 
eject the paper. If that doesn’t work, turn off the printer, open 
the cover, and pull the paper out from the front, including any 
torn pieces. Then turn on the printer, reload paper, and press 
the ) paper button.

Red H ink light 
flashes

One of the cartridges is low on ink. Check the message that 
appears on your screen to determine which cartridge is low. 
Make sure you have a replacement cartridge.

Red H ink light is on One of the cartridges is out of ink or not installed. Make sure 
you have a replacement cartridge, then follow the steps on 
page 26 to install it.

If you have just installed a new cartridge, it may be 
incompatible with the printer or incorrectly installed. Reinstall 
it or replace it with the correct cartridge.

Green P power 
light and red H ink 
light are on

An ink cartridge is not installed correctly. Reinstall it as 
described on page 26.



32 Solving Problems

Problems and Solutions

You see banding (light lines).

■ Make sure the paper Type or Media Type setting matches the paper you’re 
using.

■ The print head nozzles may need cleaning; follow the instructions below to 
clean the print head:

1. Make sure the printer is turned on but not printing, and the red H ink 
light is off. 

2. Windows: Right-click the  printer icon on your taskbar (in the lower 
right corner of your screen). Select Head Cleaning.

Red ) paper and H 
ink lights flash 
alternately

Paper may be blocking movement of the print head. Turn off 
the printer, then open the cover and remove any jammed 
paper or other foreign objects. Turn the printer back on. If the 
lights are still on, contact Epson as described on page 34.

Green P power 
light is off; red ) 
paper and H ink 
lights flash

The printer may have an internal error. Turn off the printer, 
wait a few seconds, and turn it on again. If the lights are still 
flashing, contact Epson as described on page 34.

Lights Explanation
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Note: If you don’t see the icon, go to your printer properties window as 
described on page 8, click the Maintenance tab, then select Head Cleaning.

Macintosh OS X: Open the Applications folder and select Epson Printer 
Utility. Select Stylus C87 in the printer list, click OK, and select Head 
Cleaning.

3. Click Start or Next.

Cleaning takes several seconds. The printer makes noise and the green P 
power light flashes.

Caution: Never turn off the printer while head cleaning is in progress. You 
may damage the printer.

4. When the green P power light stops flashing, make sure paper is loaded 
in the printer, then do the following:

Windows: Click Print Nozzle Check Pattern. Then click Print. 

Macintosh: Click Confirmation, then click Next.

The nozzle check pattern prints.

5. If the nozzle check pattern has no gaps or white 
lines as shown, click Finish.

If the pattern has gaps or is faint, click Clean to 
clean the print head again.

You can also turn the printer off and wait 
overnight. This allows any dried ink to soften. 
Then try cleaning the print head again.

■ The ink cartridges may need replacing; see page 26 for instructions.

Your printout is blurry or smeared.

■ Make sure the printable (whiter) side of the paper is face-up. 

■ Use Epson papers to ensure proper saturation and absorption of genuine 
Epson ink.

■ You may need to align the print head. See the on-screen User’s Guide for 
instructions.
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Your paper doesn’t feed correctly or jams in the printer.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the 
edges to separate the sheets, then reload it.

■ If paper jams, press the ) paper button for several seconds to clear the jam. If 
that doesn’t work, open the cover and pull the paper out from the front, 
including small pieces that may have torn off. Reload the paper and press the 
) paper button.

■ Heavily saturated prints may curl, causing a paper jam when printing on both 
sides of the paper.

■ Make sure you use new, smooth, high-quality paper, loaded printable side up.

■ Don’t load paper above the arrow mark inside the left edge guide. 

■ Place the paper against the right edge, behind the tab. Slide the left edge guide 
against it, but not too tightly.

Where To Get Help

Internet support service in Latin America 

Telephone support service in Latin America

Service Access

World Wide Web From the Internet, you can reach Epson Support at 
www.latin.epson.com. At this site, you can download 
drivers and other files, access troubleshooting 
information, and receive technical advice through 
e-mail.

Country Telephone number

Argentina (54-11) 4346-0300

Brazil (55-11) 4196-6350

Chile (56-2) 230-9500

Costa Rica (506) 210-9555
(1-800) 377-6627
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Note: If your country does not appear on the list, contact the nearest Epson sales 
office.

Toll or long distance charges may apply. 

Please have the following information ready:

■ Product name (Epson Stylus C87)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

■ Description of the problem

You can purchase genuine Epson ink and paper from an authorized Epson reseller. 
To find the nearest reseller, please call your nearest Epson sales office.

Colombia (57-1) 523-5000

Mexico
Mexico City
Other cities

(52-55) 1323-2052
01-800-087-1080

Peru (51-1) 224-2336

Venezuela (58-212) 240-1111

Country Telephone number
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Requirements and Notices

Windows System Requirements

■ A Microsoft® Windows compatible PC with a Pentium®-equivalent processor 
(233 MHz or faster recommended)

■ Microsoft Windows 98SE, Windows Me, Windows 2000, or Windows XP

■ At least 64MB RAM (128MB recommended)

■ 100MB free hard disk space (200MB or more recommended)

■ VGA or better display adapter and monitor (SVGA for Windows XP)

■ CD-ROM or DVD drive for installing the printer software

■ Parallel connection: a high-speed, bidirectional IEEE-1284 compliant parallel cable, 
up to 3 meters (10 feet long); the cable must have a D-SUB, 25-pin, male connector 
for your computer, and a 36-pin, Centronics® compatible connector for the printer.

USB connection: a computer with preinstalled Windows 98 SE, Me, 2000, or XP, 
and a Windows-compliant USB port and shielded USB “AB” cable. Using an 
improperly shielded USB cable may cause the printer to malfunction. 

Macintosh System Requirements

■ An Apple® iMac™ series or Power Macintosh G3, G4, or G5 with a built-in 
USB port

■ Macintosh OS X 10.2 or later 

■ 128MB RAM (256MB recommended)

■ At least 100MB free hard disk space (200MB recommended)

■ VGA display or better

■ CD-ROM or DVD drive for installing the printer software.

■ A shielded USB “AB” cable. Using an improperly shielded USB cable may cause the 
printer to malfunction.
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Important Safety Instructions

Before using your printer, read these safety instructions to make sure you use it safely 
and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets 
on the same circuit as photocopiers or air control systems that regularly switch on 
and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of 
the devices plugged into the extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total ampere rating of all devices plugged into the wall outlet does 
not exceed the outlet’s ampere rating.

■ Keep your printer and computer system away from potential sources of 
electromagnetic interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or 
vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation, leaving at least 
10 cm (3.9 inches) between the back of the printer and the wall.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all 
directions. The printer will not operate properly if it is tilted or at an angle.

■ When transporting or storing the printer, don’t tilt it, stand it on its side, or turn it 
upside-down. This may allow ink to leak from the ink cartridges.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do 
not spill liquid on the printer.

Caution: Always turn the printer off using the P power button. Don’t switch off the 
power strip or unplug the printer until the green P power light is off.

■ Do not block or cover the openings in the printer’s case or insert objects through 
the slots. 

■ Except as specifically explained in this manual, do not attempt to service the 
printer yourself. 

■ Unplug the printer and refer servicing to qualified service personnel under the 
following conditions:
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If the power cord or plug is damaged; if liquid has entered the printer; if the printer 
has been dropped or the case damaged; if the printer does not operate normally or 
exhibits a distinct change in performance. Adjust only those controls that are covered 
by the operating instructions.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around 
the ink supply port. If ink gets on your skin, wash it off with soap and water. If it 
gets in your eyes, flush them immediately with water.

■ Do not put your hand inside the printer or touch a cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its package. Leaving 
the cartridge unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the cartridge carton. For best 
results, use up the ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ Store ink cartridges with the bottom of the packaging facing down.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at 
room temperature for at least three hours before using it.

■ Do not shake an ink cartridge after removing it from its package; this can cause 
leakage.

■ Do not remove or tear the label on an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the 
print head.

■ Do not touch the green IC chip on the front of the cartridge. This may affect normal 
operation and printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and 
dust and store it in the same environment as the printer. Note that there is a valve in 
the ink supply port, making covers or plugs unnecessary, but care is needed to prevent 
the ink from staining items that the cartridge touches. Do not touch the ink cartridge 
ink supply port or surrounding area.

■ Before transporting the printer, make sure the print head is capped in the far right 
position and the ink cartridges are in place. Secure the ink cartridge holder with the 
included insert to make sure it remains in the proper position.
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Specifications

Printing

Printing 
method

On-demand ink jet

Nozzle 
configuration

239 nozzles; Black: 180 nozzles; color: 59 nozzles for each color 
(cyan, yellow, magenta)

Print direction Bidirectional with logic seeking

Ink Cartridges

Color Black: T063120, Cyan: T063220, Magenta: T063320, and 
Yellow: T063420

Cartridge life 6 months at 25 °C (77 °F) after opening the package

Temperature Storage: –20 to 40 °C (–4 to 104 °F)

1 month at 40 °C (104 °F)

Transit: –30 to 50 °C (–22 to 122 °F)

10 days at 50 °C (122 °F)

Freezing*: –16 °C (3.2 °F)

Dimensions 12.7 (W) × 73.5 (D) × 55.3 mm (H)
(0.5 × 2.9 in × 2.2 in)

*Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

Note: To ensure good results, use genuine Epson ink cartridges and do not refill 
them. Other products may cause damage to your printer not covered by Epson’s 
warranty.

Do not use an ink cartridge if the date on the package has expired.

Mechanical

Paper feed 
method

Friction

Paper path Automatic sheet feeder, top entry

Sheet feeder 
capacity

About 150 sheets at 90 g/m² (24 lb.)
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Dimensions Storage: 460 mm (W) × 242 (D) × 191.2 mm (H) 
(18.1 × 9.5 × 7.5 in.) 

Printing: 460 (W) × 437 (D) × 309 mm (H)
(18.1 × 17.2 × 12.2 in.)

Weight 4.2 kg (9.2 lb.), without ink cartridges

Electrical

Rated voltage AC 100 - 240 V

Input voltage 
range

90 - 264 V

Rated 
frequency 
range

50 to 60 Hz

Input 
frequency 
range

49.5 to 60.5 Hz

Rated current 0.4 - 0.2 A

Power 
consumption

Approx. 19 W (ISO 10561 Letter pattern)

Approx. 4.5 W in sleep mode

Approx. 0.8 W in power-off mode

Note: Check the label on the back of the printer for the voltage information.

Environmental

Temperature Operation: 10 to 35 °C (50 to 95 °F)

Storage: –20 to 60 °C (–4 to 140 °F)

1 month at 40 °C (104 °F)

Transit:* –20 to 60 °C (–4 to 140 °F)

120 hours at 60 °C (140 °F)

Humidity Operation: 20 to 80% RH**

Storage*: 5 to 85% RH**

* Stored in shipping container

** Without condensation

Scanning

Scanner type Flatbed color image scanner

Photoelectric 
device

CIS
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio or 
television reception. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause interference to radio and television 
reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

■ Consult the dealer or an experienced radio/TV technician for help.

Effective pixels 5100 × 7020 pixels at 600 dpi, 100%

Maximum 
document size

8.5 × 11.7 inches (216 × 297 mm)
US letter or A4 size; the reading area can be specified from your software

Scanning 
resolution

600 dpi (main scan)
1200 dpi with Micro Step Drive™ (subscan)

Output resolution 75, 100, 150, 200, 300, 600, 1200, 2400, 4800, 9600, and 19200 dpi

Image data 16 bits per pixel per color internal
1 to 8 bits per pixel per color external

Interface USB 2.0 

Light source RGB three color LED

Reliability 18000 cycles of carriage movement (main unit MCBF) 

Standards and Approvals 

Safety UL 1950; EN 60950 (VDE); CSA C22.2 No. 950

EMI FCC part 15 Subpart B class B; CSA C108.8 Class B
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WARNING 

The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which 
exceed the limits established by the FCC for this equipment. It is the responsibility of the 
user to obtain and use a shielded equipment interface cable with this device. If this 
equipment has more than one interface connector, do not leave cables connected to 
unused interfaces. Changes or modifications not expressly approved by the manufacturer 
could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.



Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/
or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR 
Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is 
identical to the representative unit tested and found to be compliant with the standards. 
Records maintained continue to reflect the equipment being produced can be expected to 
be within the variation accepted, due to quantity production and testing on a statistical 
basis as required by 47CFR §2.909. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation.

Trade Name: Epson

Type of Product: Ink Jet Printer

Model: B251A

ENERGY STAR Compliance

As an ENERGY STAR® Partner, Epson has determined that 
this product meets the ENERGY STAR guidelines for energy 
efficiency. The EPA ENERGY STAR office equipment 
program is a voluntary partnership with the computer and 
office equipment industry to promote the introduction of 
energy-efficient personal computers, monitors, printers, fax 
machines, and copiers in an effort to reduce air pollution 
caused by power generation.



Limited Warranty
1.  Limited Warranty for Epson Products

Epson products are covered by warranty against defects in workmanship and materials when 
operated under normal use and handling conditions, as indicated in the product documentation, for 
the period specified in section “Limited Warranty Coverage”. Coverage begins as of the date of 
delivery to the purchaser by Epson or by an authorized Epson dealer (see “Epson Subsidiaries and 
Offices in Latin America”), in the country of purchase. 

Epson also guarantees that the consumables (ink cartridges, toner, batteries) included with the 
product, will perform according to the usage specifications as long as they are used prior to the 
expiration of their warranty period.

2.  Scope of Warranty

Should Epson receive notice of a defect during the warranty period, it may, at its discretion, repair or 
replace the defective product at no cost to the purchaser. In the event of a replacement, the replaced 
equipment will become property of Epson. The replaced item may be new or previously repaired to 
the Epson standard of quality, and will assume the remaining warranty period of the product that 
was originally purchased.

This warranty does not include any compensation or damages whatsoever, resulting from the 
operating failures of the Epson product. In any event, Epson’s maximum liability toward the 
purchaser will be limited to the purchase price paid to Epson or to the authorized dealer.

Epson’s warranty does not cover any software not manufactured by Epson, even when delivered with 
an Epson product. The software may have a warranty provided by the manufacturer, as indicated in 
the documentation attached thereto.

3.  Limitations and Exclusions

The warranty will be invalid in the following cases:

3.1 When the product’s serial number has been removed or altered.

3.2 When the product has been misused, has undergone unauthorized modifications, has been used 
or stored in ways that are not in compliance with the environmental specifications of the 
product.

3.3 When the damage resulted from the use of refilled supplies or consumables, or when damages 
are the result of use of media that does not meet the product’s specifications.

3.4 When damages resulted from the inappropriate transport of the equipment (packaging, 
installation, maintenance, transportation).

3.5 When damages were caused by natural or intentional disasters (fire, floods, lightning, 
earthquakes, etc.), power surges, or interaction with other brand products. 

3.6 When the product has been totally or partially disassembled, or has been repaired other than by 
an Epson Authorized Service Center.

3.7 When substances have been spilled on the product.
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3.8 When the external plastic case has been scratched or abused.

3.9 When damages resulted from inappropriate tests, installation, maintenance or adjustments.

The warranty does not extend to accessories (lids, covers, trays) or replenishing supplies and 
consumables (ink cartridges, toner, ink ribbons, batteries, photosensitive units, knobs, print heads, 
lamps), which, due to their nature, must be regularly purchased through authorized dealers. 

4.  How To Obtain Warranty Service

Please refer to the user documentation to ensure that the product settings have been properly set and 
to perform the diagnostic tests indicated therein. Furthermore, in order for the unit to operate 
optimally, always use original Epson supplies and consumables.

To obtain warranty service, the purchaser may take the product to any Authorized Epson Service 
Center, along with proof of purchase, or call any of the Epson Technical Assistance Centers (see 
country list starting on page 45). 

Upon calling an Authorized Epson Service Center, the purchaser will be asked to provide the 
product model and serial numbers, and may be asked to provide information on the location and the 
date of purchase (the warranty is only valid in the country of purchase).

If the product warranty includes on-site service assistance, it will be provided on the next working 
day in the cities where this service is offered by Epson.

If there are no Authorized Service Centers in your area, call the Technical Assistance Center for 
service referral.

5.  Responsibilities of Purchaser

The purchaser is responsible for the safety of all confidential and proprietary information stored on 
the product, as well as for recovery backup files in case of damage. Any activity related with the re-
installation or resetting of the software that was delivered with the equipment, will be billed to the 
purchaser at the rates in effect at the Epson Service Center. This also applies if the failure was the 
result of a defect in the purchaser’s proprietary software or of a computer “virus”.

In order to obtain on-site service, the latter will be required to provide: access to the product; an 
appropriate working area; access to electrical facilities; access to the resources that may be necessary 
for the installation, repair or maintenance of the unit; a safety environment for Epson staff and their 
work tools.

6.  Limited Warranty Coverage

Technical Support Service

Epson offers technical assistance through electronic and telephone services. Before calling Epson, 
refer to the documentation included with your product. If you do not find the solution to your 
problem, visit Epson’s website at: http://www.latin.epson.com or call the local Epson office or an 
authorized dealer.

Product Model Coverage Conditions

Ink jet printer Epson Stylus One year Service center
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Service Centers

If your country does not appear on the preceding list, please contact the dealer where you purchased 
the product.

You may receive help or consult information online for all Epson products. Register your 
Epson equipment on our website, at http://www.latin.epson.com.

Extended Warranty Support and Service

In some countries, Epson offers warranty extension services. You may purchase this service by calling 
the Technical Service Center.

Epson Subsidiaries and Offices in Latin America 

Country Telephone number Web site

Argentina (54-11) 4346-0300 www.epson.com.ar

Brazil (55-11) 4196-6350 www.epson.com.br

Chile (56-2) 230-9500 www.epson.cl

Colombia (57-1) 523-5000 www.epson.com.co

Costa Rica (50-6) 210-9555 www.epsoncr.com

Mexico (52-55) 1323-2052 www.epson.com.mx

Peru (51-1) 224-2336 www.epson.com

Venezuela (58 212) 240-1111 www.epson.com.ve

Epson Argentina S.A.
Avenida Belgrano 964/970
(1092), Buenos Aires
Tel: (54 11) 4346-0300
Fax: (54 11) 4346-0333

Epson Colombia, Ltda.
Diagonal 109, No. 15-49
Bogotá, Colombia
Tel: (57 1) 523-5000
Fax: (57 1) 523-4180

Epson Perú, S.A.
Av. Del Parque Sur #400
San Isidro, Lima, Perú
Tel: (51 1) 224-2336
Fax: (51 1) 476-4049

Epson do Brasil, Ltda.
Av. Tucunaré, 720
Tamboré Barueri, 
São Paulo, SP 06460-020
Tel: (55 11) 4196-6350
Fax: (55 11) 4195-5624

Epson Costa Rica, S.A
Embajada Americana, 
200 Sur y 300 Oeste
San José, Costa Rica
Tel: (50 6) 210-9555
Fax: (50 6) 296-6046

Epson Venezuela, S.A.
Calle 4 con Calle 11-1
La Urbina Sur
Caracas, Venezuela
Tel: (58 212) 240-1111 
Fax: (58 212) 240-1025

Epson Chile, S.A.
La Concepción 322
Providencia, Santiago
Tel: (56 2) 484-3400
Fax: (56 2) 484-3413

Epson México, S.A. de C.V.
Blvd. Manuel Ávila Camacho 389
Edifico 1 Conjunto Legaria
Col. Irrigación, C.P. 11500
México, DF
Tel: (52 55) 1323-2000
Fax: (52 55) 1323-2183
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